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Art 198
01-CSS-Layout – Newsletter Project: Layout in
Dreamweaver using the CSS Box Model

(Adapted from Betsy Bruce, author of Sams Teach Yourself Macromedia Dreamweaver in 24
Hours)

Browser support for CSS has finally made it possible to build powerful site structures and layouts
using CSS positioning and the box model. Build flexible, powerful layouts that provide a cleaner
code structure—and more design freedom and power than possible with tables. Note: For ease of
learning CSS layout, this tutorial will be viewed in a modern browser, Firefox, to render the styles
according to the W3 standards. We will learn the appropriate work around to make our site work

with many other browser’s that are not up to full standards later.

View the layout-sketch.pdf found in the newsletter-layout folder. The final web page is a fixed
width centered layout with stacked divs for masthead, subtitle, and maincontent and siteinfo. The
maincontent has two or three columns. Two columns are positioned by floating one right and one
left. The right column has one floated image with text wrapping around the left and bottom. The
overall content is 760 pixels wide and centered in the viewport using margin left and right auto.
Our layout uses a pagewrapper div container to set this width and allow us to add design
features, like a background color, to the content. Ems are used for font, margin and block height
to make the layout respond to changes in font size by the user and still be readable (not have
content cut off or overlap). There is also a second page for the full text of the feature article that
uses a single column in maincontent. You can see the final results in the finished folder included

in this tutorial.

Set-Up: Defining the Site

Objective: Define the local root site folder that you will keep all your files in and create the new

basic html page for our tutorial.

Before starting this exercise, unzip the tutorial files. To preserve the original tutorial files, Copy
and rename the start folder by adding your initials (newsletter-layout-xx). Define the site (or
folder) where all the images and html files will be located. In this case, we will nickname the site

as newsletter.

Steps

1. Site>Manage Site.
2. In dialog box, choose New>Site and click on that button.
3. In the Advanced tab, in the Site name field, nickname your site newsletter.
4. For Local root folder: browse to your tutorial files - click on the Folder Icon to navigate

to your folder entitled newsletter-layout-xx..
5. For Default images, click on the Folder icon to navigate to your images folder inside the

start folder.
6. Make sure that Links relative to: Document is check and Cache: Enable Cache is

checked.
7. Click on the OK button in the Site Definition dialog
8. Finally click on the Done button for the Manage Sites window.
9. When you look in your Files panel, you will see your files and folders in the tutorial files
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selected for your site.

Creating the HTML Structure Markup

Exercise 1: Markup the newsletter content with valid xhtml strict
elements, adding semantic structure.

Objectives

 Open a new html document
 Copy and paste the content of the text file into design view

 Add semantic structure with proper html headings, lists, images elements

Steps

1. From the Welcome panel, select Create New > html and save it in the start folder as index-
yourinitials.html

2. From the Files panel, open the start folder, then the assets folder and double click on main-
page.txt to open in Dreamweaver

3. This is the content or client wants on the main page of the newsletter. It has notes that help
the designer know how each bit of copy will be used. Select all of the text (CMD or CTRL A)
and copy (CMD or CTRL C) and paste it into the Design view of the new index html file we
just made. Make sure you are pasting in Design view, NOT Code view. Most of the content
will have automatically added to our web page as paragraph elements.

4. Using the Properties panel, go through the document and change the headings to the
appropriate heading level elements.

5. 

6. In the feature copy, right after the heading and before the first word of the paragraph, insert
the cactus-garden.jpg image, adding the alt text, cactus garden.

7. In the What’s Blooming text, mark up the unordered list. The easiest way to change existing
text is to make sure that each list item is a separate paragraph, so select the break tags and
press the RETURN or ENTER to separate into individual paragraphs. Then select all the list
items and in the Properties Panel, click on the unordered list icon.

Exercise 2: Planning the division boxes needed to achieve our
newsletter layout.

Open the completed newsletter page in the browser. In Firefox, File > Open File and

browse to the finished web page in newsletter layout > finished >index-

completed.html and view in the browser. Think about where the block elements are

needed to organize our content into the masthead, subtitle or issue info, the two

articles and the footer. Then open the layout-sketch pdf to see the planned layout
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and the finished page with the division boxes overlaid. We will have:

 One pagewrapper division to center and fix the width of our page

 Nested inside the pagewrapper will be 4 stacked boxes:

o masthead

o subtitle

o maincontent

o siteinfo

 Inside the maincontent division we will have the two columns for our article

copy:

o feature

o article

 In the final version we will add the sidebar as a column next to the

maincontent, with 2 more stacked boxes:

o blooming

o events
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Exercise 3: Creating a Page Wrapper to Center Content in the
Browser Viewport.

Often it's necessary to place the page content in a container, especially for a fixed width page
style, and set the margins to center the page layout. Working from the outside in, we will begin

forming the division blocks that will be used to define our layout.

Objectives

 Create a new division element <div> in the html structure using Dreamweaver's Layout
Object > Div Tag

 In the html structure, give the division an ID <div id=”pagewrapper”>
 Add a css rule to help visualize divisions as we block the content.

Steps

1. In Design view, select all (CMD or CTL A)

2. From the Dreamweaver Toolbar, select Insert > Layout Objects > Div Tag

3. In the dialog box, wrap around selection should be chosen and enter pagewrapper into the
id field and click OK. You will see in the code view that the new division with an id of
pagewrapper now contains all of the content inside the body tag.

4. Add a comment to mark the end of this div while the code is still selected, scroll to the end of
the highlighter area to the closing div, which is just before the closing body tag, to add the

comment code <!--end #pagewrapper-->. From the Insert Panel, click on the
Comment icon

or from the left side of the code view select the comment icon and choose Apply HTML
Comment
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and type end #pagewrapper as the comment. The beginning div has the id attribute, now

the ending div has the comment to help us know where each new division starts and ends.
Do this routinely every time you add a division and your work will be greatly simplified.
Browsers ignore text in comment tags, but anyone looking at or working with your code later
(including yourself) will find your comments very useful. Dreamweaver shows comments in
light gray color in the code view.

5. In Design view, Dreamweaver displays a slight dotted outline for each division. To make this
more visible and clearly show the nesting of our layout blocks, we are going to redefine the
html element div to show some margin and a dotted blue border. Click anywhere in the
pagewrapper div and go to the CSS panel and click the create new css rule icon

In the resulting dialog box make sure that Tag is the selector type and div is the selector and
this document chosen. You will probably have to change the Selector Type to change from
the default ID and #pagewrapper that DW picks. And click OK
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6. In the New CSS Rule dialog choose the category Box, and set margin to 5px. Choose Border
and set all to Style: dotted, Width to medium and Color to a blue and click OK.

7. Now the pagewrapper is clearly outlined with a dotted blue border and you will be able to see
the nested divisions that we are adding inside the wrapper division as follows..

Exercise 4: Creating 5 main blocks inside the wrapper division:
masthead div, subtitle div, maincontent div, sidebar div and siteinfo
div.

Inside the pagewrapper container, the newsletter copy content will be grouped up into 5 primary

stacked blocks, masthead, subtitle, maincontent and siteinfo.

Objectives

In the html structure, create divs inside the pagewrapper div to form the block structure of

the page content using Dreamweaver's Div Tag object and create the IDs.

Steps

1. In Design view, select the text marked as (h1)Masthead image and newsletter title
(masthead div)

2. From the Dreamweaver Toolbar, select Insert > Layout Objects > Div Tag

3. The option wrap around selection should be chosen and enter the ID masthead in the field.
Check your code view to make sure only the intended text is inside the div. While the code is
still selected, scroll to the closing div and add the comment code to mark the end of the

masthead div. <!-- end #masthead -->

4. The next block is the subtitle. Select the text from (subtitle div) to (end subtitle) and again
from the Toolbar, choose Insert > Layout Object > Div Tag and making sure that Wrap
around selected is chosen, type subtitle in the ID field and click OK. Add a comment tag just

before the closing div to mark the end of this division <--end #subtitle-->

5. Continue to repeat these steps for the remaining division content for maincontent, sidebar
and siteinfo selecting the copy text as marked in the copy.for each division.

Exercise 5: Create divisions for the 2 areas of maincontent: feature
div, article div, and 2 areas in the sidebar div: blooming and events.

Inside the maincontent division, the copy content will be grouped up into blocks for feature and,
article, and the sidebar division contains 2 more divisions, blooming and events. This concludes

the html structure.

Objectives

In the html structure, create divs inside the maincontent div to form the block structure of
the main content using Dreamweaver's Div Tag object and create the IDs. Nest the

sidebar content for what’s blooming and events as divs within the sidebar div.

Steps

1. In Design view, inside the maincontent div select the text marked feature and once again,
choose Insert > Layout Object > Div Tag to create a division around the feature article text.
Type feature in the ID field. Confirm that the proper text is in this division tag, and while

selected, scroll to the closing tag and add the comment <-- end #feature -->.

2. Repeat this step for the remaining article division.
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3. Inside sidebar create 2 additional nested divs each for blooming and events.

4. Now that we have all of our building blocks established, go through the document and delete
the division label text, html element hints and everything but the real copy, leaving only the
note for (a href 2009-20-10-centennial.html), which we will need later when we make the
second page for our newsletter. Make sure to completely delete the text and any extra
paragraph with the text. Check for odd characters that sometimes come in from the formatted
rich text. Usually curly or smart quotes, apostrophes, em dashes, trademark or registered
symbols, etc. will not come over properly and need to be retyped or replaced with Unicode.

Replace the copy right symbol with Unicode &#169;

5. We are going to layout a simpler two column version of the newsletter first. We are going to
add a comment code to hide the sidebar for now. So click in the sidebar and in the Tag
Selector bar, select the div sidebar. In the code view add the opening comment tag by typing

<!-- and at the end of the selection, after the closing sidebar div type the closing comment

tag --> You will notice that the comment code fails to work because we already have a

comment code inside for our end of sidebar. Delete the  <-- end #sidebar --> comment
for now.

6. Save the document and close it.

Creating the Page Layout Styles

Exercise 6: Setting Page Properties Using CSS Styles
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In Dreamweaver we can use Page Properties to easily generate a variety of page level CSS
styles. You can set the body margins to zero, set the body background color, and choose the
base font family and size. Most professional web designers set the body margins to zero and set
the body font size to 100%. We will also set the link state colors in Page Properties, creating
pseudo-class selectors (a:link, a:visited, etc.) By default Dreamweaver stores the styles created
with Page Properties dialog box in the head of the current document. We will then move these

styles to an external style sheet to use in multiple pages.

Objectives

 Modify basic page text properties such as font, and font size with styles for the
body element

 Modify the margins, background colors, or background image with styles for the
body element

 Modify link state colors of a page creating pseudo-classes
 Modify heading level font, size and colors

 Review the DOCTYPE, Title and Encoding and change if necessary

Steps

1. Open the pre-baked completed structure tutorial file found in the layout folder and named
layout-start.html. Save As index.html

2. In the Properties panel click on Page Properties to open the Page Properties dialog box (or
from the Toolbar, select Modify > Page Properties)

a. In the Appearance category

 Set Page font to Verdana, Geneva, sans-serif.

 Set Size by typing 100%.

 Text color to #1D2F29

 Background color to #334841

 Set Margins to 0 pixels.

b. Switch to the Links category display

 Set the Link color to #B83D17

 Set the Visited links color to #8C422A

 Set the Rollover (hover) links to #C61838
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 Set the Active links to #F76D1C

c. Switch to Title/Encoding category

 The Title should already show Huntington Botanical Gardens – Fall
Newsletter

 Make sure the Document type is set to XHTML 1.0 Strict

 and Encoding is set to Unicode 4.0 UTF-8XHTML 1.0

d. Click OK.

e. In the code view review the <style> element and rules that the Page

Properties dialog box has added to the <head> element of our document.

Exercise 7: Deleting the Redefined HTML Div Tag Selector and
Exporting Styles as External Style Sheet and Linking to the External
Style Sheet

By default Dreamweaver stores Page Properties CSS in the <head> of the current document in

the <style> element, along with the style we temporarily set for the div element to make it
easier to see the nested div blocks. We want remove the style for the div and move the page
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property created styles to an external style sheet that will control our multiple pages.

Objectives

 Remove the temporary style for html tag div
 Move remaining page styles embedded in the head of a page to an external style

sheet

 Attach an external style sheet to a page

Steps

1. In the CSS Styles Panel click on the triangle to display all the rules that were just created
using the Page Properties dialog as well. In the CSS Panel, with the All tab selected, you will
see <style> indicating that there are styles in the head of this page. Click on the triangle to
display all the rules, including those that were just created using the Page Properties dialog.
You will see a body, th, td rule and another body rule. You will see a:link, a:visited,
a:hover, a:active rules. Note the order for the link rules. They must be in this order (link,
visited, hover, active) to work properly. When adding the rules individually, use the mnemonic
device LoVe Hate to help.

2. Select the div rule that we used to temporarily show our division boxes nested and while
selected, click on the trash can icon (delete CSS rule).

3. In the CSS rules list, shift and click to select the remaining rules. Right click while still
selected and choose Move CSS Rules…

4. The Move to External Style Sheet dialog box opens.

Choose a new style sheet button and click OK. In the files Finder or Explorer dialog box,
browse to your tutorial layout folder and inside it to the css folder and save the file here as
base.css.
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5. Dreamweaver strips the rules that were in the <head> in the <style> tag and automatically
creates the external style sheet called base.css with the rules and links our index file to the

new style sheet. If you look at the CSS panel, you will now see both the <style> in the
head and the linked base.css in the All view. If you click the triangle to view the base.css
you will see that the rules are now in the external style sheet and not in the embedded style
element in the head. Since we do not want any styles embedded in our index.html document,
delete the remaining empty <style> tag in the document <head> by selecting the <style> in
the CSS Styles panel and clicking the Delete CSS Style icon (trash can). Now you will only
have the proper <link> tag to the new style sheet.

All of our styles that we set earlier are still applied to our document by the external style sheet
now that it is linked in the head.

Exercise 8: Adding New CSS Styles to Define the Layout

Objectives

 Use CSS box model to position the various division blocks

Steps

1. Click any where in the content and then select the div#pagewrapper in the Tag Selector bar

2. With div#pagewrapper selected, go to the CSS panel, and click the New CSS Rule Icon
(page with +)

3. In the New CSS Rule dialog box:

• You should see that Dreamweaver automatically selected ID (Applies to only one
HTML element) as the Selector Type.

• And named the selector #pagewrapper (# indicates this is an id type selector in the
style sheet.).

• For Defined in make sure that the external style sheet base.css is selected.

• Click OK
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4. In the New CSS Style Definition dialog box.

• Select Background category

a. Background-color: #9EB6AB

• Select the Box category.

a. Width: 758px (this width plus 2px for a border on each side equals 760, the
width of the viewport on an 800x600 resolution screen without the browser
"chrome" like the scrollbar).

b. Under Margins, uncheck the Same for all, and set right and left Margins to
auto. This will center our 760 pixel fixed page width in the viewport of the
browser.
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• Select the Border category

a. uncheck Same for all and set 1 pixel solid borders color #BCCFB7 on all
sides except the top.

5. Once you have defined this rule with box properties in the CSS Rule Definition dialog, click
OK.

6. If you look in your CSS Panel, you will see the new rule for #pagewrapper with the
properties we just set. Right click on the #pagewrapper rule and choose Go To the Code.
Dreamweaver will switch to the base.css in code view. Notice the code syntax for rules we

have created. The ID we created for #pagewrapper is preceded with a #, while the Tag

selectors (HTML elements) such as body do not.

You can use ID selectors to position and format <div>s, or divisions, think container, for laying out
content on web pages. In the CSS file, the name of a class selector always begins with a period

for example .date and in the html document you may apply a class multiple times within a page.

In the CSS file the name of an ID selector always begins with a pound or hash symbol (#) and in
the html source document it may only be used once within a page. In the html source document,

when we simply use the name in quotes, not the period or #, so <div id="pagewrapper"> or
<p class="date">
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Exercise 9: Creating a masthead ID selector CSS rule

We want to use a background image for the masthead and have the actual HTML

heading text for Huntington Botanical Garden Newsletter show in front. We need to

specify the height for the division to make sure the background image shows

properly. This is one of the few times that the height property is used. Normally we

let the contents define the height of elements.

Objectives

 Define a new style rule for selector #masthead
 Add height property to define the masthead vertical dimension to match the

height of the masthead image we will ultimately add here as a background

image.

Steps

1. Click in the Document window to place your I-beam in the masthead div and select
div#masthead in the Tag Selector bar.

2. Go to the CSS Styles panel and add a New CSS Rule for the ID #masthead in the base.css
file

3. In the New CSS Rule Definition dialog box:

• Select the Box category.

a. Enter height: 150px.

4. Click OK to save the style.

5. In the CSS Styles panel, Select the style #masthead and right click and choose Go to the
code. Find the css rule #masthead that we just created with its property and value for height.

Exercise 10: Creating a subtitle ID selector CSS rule, maincontent
wrapper ID selector CSS rule and siteinfo ID selector CSS rule

Objective:

 See how the container divs naturally stack up one on top of the other inside the
pagewrapper,

 do not need a width because by default they expand to fill the available

width set by the page wrapper, and

 add margins to position the content inside and away from the borders.

Steps

1. Place your I-beam in the #subtitle div.

2. With the div#subtitle selected in the tag selector bar, Go to the CSS panel and add a New
CSS Rule for the ID #subtitle in the base.css file

3. In the New CSS rule dialog:

• Select Box category

a. Set padding: 15px 15px 5px; (top 15px, right 15px, bottom 5px and left 15px)

• Select Background category and set:

a. background: #F1F3CC;
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• Click OK

4. Place your I-beam in the #maincontent div.

5. With the div#maincontent selected in the tag selector bar, Go to the CSS panel and add a
New CSS Rule for the ID #maincontent in the base.css file

6. In the New CSS rule dialog:

• Select Box category and set margins on the sides and bottom:

a. margin: 0 15px 15px; (top 0px, right 15px, bottom 15px and left 15px)

• Click OK

7. Place your I-beam in the #siteinfo div.

8. With the div#siteinfo selected in the tag selector bar, Go to the CSS panel and add a New
CSS Rule for the ID #siteinfo in the base.css file

9. In the New CSS rule dialog:

• Select Box category and set margins to match the maincontent div, with a little more
margin on the bottom:

a. margin: 0 15px 20px; (top 0px, right 15px, bottom 20px and left 15px)

• Click OK

Exercise 11: Layout the Two Columns

Create columns using the float property. This property enables containers like divs to float beside

other elements just as you can do with images.

Objectives

 Add  CSS Rules for "nested" feature and article divisions for the content columns

within the parent container <div id=”maincontent”>
 Use calculated width to fit within the size of the parent container <div

id=”maincontent”>
 Use the float property to create columns

1. At this point the content we want in two columns is stacked as blocks on top of one another.
In the next steps we will set a width and float the article division to the right within the
maincontent div container. Since our overall pagewrapper plus it's borders is 760 pixels, we
will do the math to find out what each column width should be:

760 – 2 (borders) – 30 (margins on maincontent) – 16 (gutter) ÷ 2 = 356.

2. Place your I-beam in the #feature div.

3. With the div#feature selected in the tag selector bar, Go to the CSS panel and add a New
CSS Rule for the ID #feature in the base.css file

4. Check that the ID name is #feature (click Less Specific to delete any IDs preceding it)..

5. In the New CSS rule dialog:

• Select Box category

a. Enter width: 356px;

b. Enter float: left;

6. Click OK.

7. Place your I-beam in the #article div.

8. With the div#article selected in the tag selector bar, Go to the CSS panel and add a New
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CSS Rule for the ID #article in the base.css file

9. Check that the ID name is #article (click Less Specific to delete any IDs preceding it)..

10. In the New CSS rule dialog:

• Select Box category: In order for the 2
nd

 column to clear the entire left column, even if it's
content is longer, we give it a left margin that is the width plus the gutter (356 + 16), and since
there is an odd pixel, we will add it here. We do not need to set a width. The content will be
constrained to the remaining space in the parent maincontent container div.

a. Enter margin-right: 372px; (356px of article width, plus 16px gutter between
columns)

11. Click OK.

12. If we temporarily make the article content shorter than the feature content, we will see a
typical behavior of floated columns. Place your I-beam in the second paragraph in the article
division and select the p tag in the Tag Selector bar. Switch to code view by pressing the
CTRL and tilde key ~, then click on the comment icon on the code side toolbar on the left and
choose Add HTML comment, or simply type the opening and closing comment tags around
the second paragraph.

13. Now when we preview in the browser and scroll to the bottom you will see that the left column
text is slightly outside the background color and the site info text has jumped up to the right
column under the article. This is because the floated division feature has not been cleared, it
has more vertical length below the article copy and all following content will continue to float
up and to the left until it has reached the bottom of the floated element.

14. Undo hiding the second paragraph (CMD or CTRL Z)

Exercise 12: Wrap text around the inline image

1. Select the image in the feature column and in the CSS Style Panel create a New CSS Rule:

• In the New CSS Style dialog box:

a. Selector Type should be Compound (based on your selection).

b. Selector ID name should be #feature img (Click Less Specific to eliminate any
ids to the left of this, and delete the p tag if included).

c. the external style sheet base.css should be selected.
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• In the CSS Rule Definition dialog box:

a. Set the following in the Box category:

 Float: left

 Margin-top: .45em (just to bring down the amount of the extra ascender
space in the paragraph text)

 Margin-right: 15px

 Margin-bottom: 15px

Exercise 13: Edit the CSS rule for the #siteinfo division in our layout
to clear our floated column.

Edit the siteinfo division. Make sure the siteinfo will start a new block to the left regardless of the

length of either column.

Objectives

 Use the clearfloat class to force the site info division to completely clear any

remaining floated elements whether floated right or left.

1. With your I-beam in the text for siteinfo, select the div#siteinfo in the Tag Selector and go to
the CSS Styles Panel, change the tab to current to display the properties for #siteinfo rule.

• Click on the Edit CSS icon and in the New CSS Rule Definition dialog box:

a. Set the following in the Box category:

 Clear: both

 height: 0px;

b. In the Type category set

 line-height: 0;

 font-size: 1px;

c. The last three properties and values are added to make earlier browsers
properly clear the floats.

2. There you have it! We have now completed and placed all the basic layout boxes as we
designed in the layout-sketch.pdf.

Creating the Page Design Styles

Exercise 14: Add the background image to the masthead

You can open the “pre-baked” styles-start.html file in the styles folder which is the file where we left off
in the layout tutorial. Save As index.html

Objectives

 Using the background image and background color properties add our masthead

image.

1. In the CSS Styles Panel, with All rules showing, select the #masthead selector and click on the edit
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pencil icon at the bottom of the panel 
to open the CSS Rule definition dialog box:

• Select the Background category.

a. Choose a pleasing Background-color for the masthead for viewers with
mages off: #D6C099

b. Click the Browse button next to Background image and select

images/huntington_banner.jpg.

c. From the Repeat dropdown menu select no-repeat.

• Click OK

Exercise 15: Style the content copy text

1. We also want our main content copy to have line-height (leading) and a smaller font size than
the default 16. In the CSS Styles Panel select the rule for #maincontent and click the pencil
icon Edit CSS Rule for the #maincontent element.

• In the Edit CSS Rule Definition dialog box:

a. Set the following in the Type category:

 Font-size: .875em (The base font size of most browsers is 16px. So to
determine the size we want for our text, say 14px, divide 14 by 16 to get .875
ems)

 Line-height: 1.4 (choose multiples which means multiples of whatever the
font setting measurement is, so here it would be 1.4 times .875ems.)

2. We want our all of our paragraphs to have bottom margin but no top margin. This helps
keep things on a horizontal line. Click on any paragraph in the main content and in the CSS
Styles panel click on the New CSS Rule icon. Click on Less Specific until you only have the
<p> tag selected. In the New CSS Rule dialog box:

• Set the following in the Box category for Margins:

a. Margins - Uncheck Same for All and set Bottom margin to .75em and all the
rest to 0.

3. We want the div#maincontent to have a minimum height, so that short pages will still look
complete in the viewport. The min-height rule is not available in the Dreamweaver dialog box,
so go to the CSS Styles Panel and select #maincontent in the All View. In the Properties
pane for #maincontent, click Add Property and type or use the drop list, to set min-height to
27em.

4. We will use a slightly smaller font for the siteinfo content. In the CSS Styles Panel select the
rule for #siteinfo and click the pencil icon Edit CSS Rule for the #siteinfo element.

• In the Edit CSS Rule Definition dialog box:

a. Set the following in the Type category:

 Font-size: .8em

5. The byline on #article should be slightly smaller and italicized

• Create a new custom class css rule from the CSS Style panel.

a. In the New CSS Rule dialog box, choose Selector Type: Class, name the
class .byline and make sure it is saving to the base.css style sheet and click
OK

• In the CSS Rule Definition dialog box:

a. Set the following in the Type category:
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 Font-size: .8em

 Font-style: Italic

Exercise 16: Adding the Title

We are going back to the masthead to add our newsletter title. We want the html

text to be in front of our banner image. We will use the positioning properties of

relative and absolute to make this work. You use this technique when you want

absolute placement of an object on the page or when you need to place an object in

front of other objects without changing its location in the source order. Absolute

positioning should be used carefully so that the element will not accidentally obscure

something else if the font size or viewport size is changed. We are going to change

the masthead div height to 9.4em. If the font size changes the masthead will

increase in height also, providing more room for the text to display without obscuring

the content below. Note: This dimension is the height of the banner image if the

browser font size is set to 16 pixels, which we already mentioned is the default for

most modern browsers. To determine the ems for your image height, divide the

actual height in pixels (150 pixels) by 16, which gives 9.375 and I rounded it up to

9.4em.

Objectives

 Redefine an HTML tag's appearance using CSS

 Add and position an element absolutely.

Steps

1. Split the long title into two lines, but one h1 element. Place your I-beam in the newsletter title
text which is an h1 element and the only one on our page, after Huntington Botanical, and
place a line break <br /> (shift + enter or return). Making sure the h1 tag is selected in the
Tag Selector bar, click the New CSS Style button.

2. In the New CSS Style dialog box:

• Select Tag (Redefines an html element) as the Selector Type.

• Make sure only h1 is selected

• Select the external style sheet base.css for the Defined in section.

3. Click OK.

4. In the New CSS Style Definition dialog box:

• Set the following in the Type category:

a. Font: Optima,"Trebuchet MS",Arial,Helvetica,sans-serif (choose the
Trebuchet MS group from the DW font list and click in the field and type
Optima, at the beginning of the font family list)

b. Size: 2.1em

c. Variant: small-caps

d. Color: #003333

• Set the following in the block category:

a. Letter-spacing: .5px

b. Word-spacing: .1em

• In the Box category

a. Set all margins to 0
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• Set the following in the Position category

a. Type: absolute

b. z-index:10;

c. left: 16px;

d. top: 10px; (This measurement will depend on the height of your banner image.
You can adjust it later if necessary)

5. Click OK to save the style definition.

6. In order for this absolutely positioned h1 element to work properly, we have to make its
parent container, #masthead, have position. An absolutely positioned element is always
positioned within the last positioned ancestor container. If we do not give position to the
#masthead, then this element will be positioned relative to the viewport or body because we
have no other elements positioned in our document tree. If you preview the document in the
browser you will see the heading is off to the left. In the CSS Panel in the All View mode,
select the rule for #masthead and then click on the Edit icon (the pencil) at the bottom of the
CSS panel.

• Set the following in the Position category

a. For Type: Relative (This provides position to #masthead, the parent div of h1,
even though we do not give it any position measurements change placement.)

7. Position the title over the masthead div. If necessary, size and position the absolute
positioned element on the screen. You can move the div by either using the drag handle in
the upper left corner OR by clicking on a border and using the arrow keys on the keyboard
OR select the h1 rule in the CSS panel All view and selecting the edit icon (pencil icon) to
open the dialog box OR directly change the Properties for h1 for Top and Left in the CSS
Property. Make sure to Preview in the browser (Dreamweaver is not always accurate in the
design view for this placement) and make adjustments as needed).

Exercise 17: Style the Newsletter Subtitle <h2> and Add an Issue
Number and Date.

Objectives

 Add an issue number and date to the subtitle, using a <span> tag and custom
class to display it differently than the style used for the subtitle.

 Add and position an element relatively.

Steps

1. With your I-beam in the subtitle text Visiting the Fall Cactus Garden, in the CSS Style
panel, create a New CSS Rule for #subtitle h2

2. In the New CSS Style dialog box:

• Select Compound (based on your selection) as the Selector Type.

• The selector name should be  #subtitle h2 (delete any ids to the left of this).

• Select the external style sheet base.css for the Defined in section.

3. In the CSS Rule Definition dialog box:

• Set the following in the Type category:

a. Font-family: Font: Optima,"Trebuchet MS",Arial,Helvetica,sans-serif
(choose the Trebuchet MS group from the DW font list and click in the field and
type Optima, at the beginning of the font family list)

b. Font-size: 1.4em
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c. Font-style: italic

d. Font-variant: small-caps

• Set the following in the block category:

a. Letter-spacing: 1.25px

b. Word-spacing: 0.1em

c. Text-align: right

• Set the following in the Box category

a. Margin – Checked Same for All: 0px

b. Padding – Checked Same for All: 0px

4. In the html page, select the text Vol. 20, No. 10, November 2008 and Right-Click and select
Wrap Tag. In the Wrap tag box, start typing sp and select the <span> tag. This wraps the
selected text in the opening and closing span tags, so that we can isolate it and display
differently it from the rest of the subtitle heading. This text should be inside the <h2> tag.
Check your code view.

 

5. In the CSS Styles Panel, create a New CSS Rule for a Selector Type Class .issue

 Be sure to clear the selector name of anything Dreamweaver input and type
.issue for the selector.

• Set the following in the Type category:

a. Font-size: 0.7em

• Set the following in the block category:

a. Letter-spacing: -0.5px (to remove the letter spacing we added for the large font)
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 Set the following in the Position category:

a. Position: relative

b. Top: 5 pixels (to bring this text down to the line with the larger font, it is shifted
5 pixels down from where it would have been and leaving space where it was
originally in the normal flow.)

c. Float: left

6. Back in the html, we need to apply this new style to the span tag containing the issue content.
Click in the Issue text and in the Tag Selector Bar, click on <span> and right click to Set
Class > issue

7. Again, just as we did for the h1 and #masthead div, in order to have the positioning for this
span be positioned relative to the #subtitle division and not relative to some other point, we
need to go back to the #subtitle rule and add the property position: relative, making it the
last positioned ancestor in the html tree for the span element.

• In the CSS Style Panel, View All, select the #subtitle rule and in the Properties pane for
#subtitle, click Add Property and type or select from the drop list, position and enter the
value: relative. This will make the parent div #subtitle have "position" to properly place
the <span class="issue"> inside this div even though we do not add any changes to
#subtitle div position.

8. Finally, be aware that this division with a background color has a floated element. In our case
the floated element is completely cleared by the following content “Visiting The Fall Cactus
Garden,” so there is no need to add a clearing div element. If your content is different, you
may need to add the clearing div as we did for the #pagewrapper to make sure that the
division with the background color is completely containing the floats.

Exercise 18: Style h3 in columns

Objectives

 The last elements left to style are the headings level 3 for each of our articles.

We will use borders and margins to add emphasis and style.

 Since both elements will have the same style, we will use multiple selectors

separated by commas to name the selector for this style.

Steps

1. With your I-beam in the h3 of the #articles div, go to the CSS Styles Panel and create a New
CSS Rule:

• In the New CSS Style dialog box:

a. Select Compound (based on your selection) as the Selector Type.

b. Name the style #article h3, #feature h3 (we can define both selectors at the
same time by separating them with a comma)

c. Select the external style sheet base.css for the Defined in section.

• In the New CSS Rule dialog box:
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• Set the following in the Type category:

a. Color: #BB2C03

b. Font-style: Italic

c. Font-weight: normal (to override the default browser style)

• Set the following in the Block category:

a. Letter-spacing: 1px

b. Word-spacing: 0.1em

• Set the following in the Box category:

a. padding: top 0.5em all the rest 0 pixels

b. margin:  bottom: 0.25em and all the rest 0 pixels

2. Click OK

3. Click in the heading for feature and selecting this h3 in the Tag Selector bar, go to the CSS
panel and create a New CSS Style

• In the New CSS Style dialog, select

a. Select Compound (based on your selection) as the Selector Type.

b. Name the style #feature h3 (Click Less Specific until it correct)

c. Select the external style sheet base.css for the Defined in section.

• In the New CSS Rule dialog

• Select Border category and set

a. border-bottom: 2px dotted #F1F3CC;

Exercise 19: Switch Column Location by Changing Style Sheet

Objectives

 Balance the layout for feature article with photo
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 Demonstrate the power of external style sheets to adjust the

presentation of the html content by swapping the location of the two

columns.

Steps

1. In the CSS Styles panel,

• in View All select #feature and in the Properties for #feature pane:

a. Change the float property to float: right.

• in View All select #article and in the Properties for #article pane:

2. Right click and chose Go to the code…

• In the code view for the rule #article:

a. Change the property margin-left: 372px; to margin-right: 372px;

3. Return to the html file tab and preview in the Firefox browser. Notice that the columns have
now swapped locations.

4. Save the current index.html if you haven’t already

Finishing up with a Second Page with Different Layout

Exercise 20: Create a Full Article Page with a Single Column Layout

Objectives

 Demonstrate how to have different page layouts within one site and

style sheet by using new IDs.

 Create a link back to the main page of the newsletter.

1. Open the pre-baked finish-start.html in the finished folder, which is the page as we left off in
the styles exercises. Save As index.html.

2. Open the full-article.txt in the start folder > assets. Copy the text at the top for the page
name: 2009-20-10-centennial.html.

3. Return to the index.html file and Save again: Save As: paste the copied text (2009-20-10-
centennial.html) as the file name and save in the finished folder.

4. Open the index.html in the finished folder once again from the files panel and select the
text Read full centennial story. In the Properties panel go to the link field and clicking on
the browse folder icon, find the file 2009-20-10-centennial.html to make link to it from the
feature article on the main page. You can now close the index.html file.

5.  In the new 2009-20-10-centennial.html in Design view, place your cursor in the #article
copy. In the Tag Selector bar, select the <div#article> tag and click the delete key on your
keyboard, to completely remove the contents and the division. This page will be a single
column of just the full feature article.

6. Go back to the full-article.txt and copy all the text

7. Return to 2009-20-10-centennial.html and select all the copy in the feature div and paste all
the full-article text to replace the feature lead-in copy. You can close full-article.txt

8. Again in Dreamweaver Design view, place your cursor in the #feature text. In the code view,

locate the <div id="feature"> and change the id to fullarticle. This is a new division ID

without the width and float properties, so it will fill the entire #maincontent container.

9. Our text copy looks fine, because it is inheriting the styles on #maincontent. However the
heading is not right. We used a compound type style to specifically define #feature h3 and
#article h3, but now we have a new #fullarticle h3. In the CSS Styles panel, with the All tab
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selected, find the rule for #feature h3, #article h3 and right click to go to the code. Type a
coma after #article h3 and then add #fullarticle h3. We probably want to make the heading a
little more elaborate, so in the CSS code we can add the #fullarticle h3 selector to the styles
we set for #feature h3 (don’t forget the coma). Now the border and larger font will apply to
this heading as well.

10. In Design view, place your I-beam next to the text (img cactus-garden2.jpg) and from the
Insert menu on the Toolbar, Insert Image and browse to the cactus-garden2.jpg image to
place it inline in the html. Add the alt attribute text Yucca cactus in the garden.

11. While the image is selected, create a New Style Rule in the CSS Style panel.

• In the New CSS Style dialog box:

a. Select Compound (based on your selection) as the Selector Type.

b. Name the style #fullarticle img (delete any other selectors that Dreamweaver
auto filled)

c. Select the external style sheet base.css for the Defined in section.

• In the CSS Rule Definition dialog box: Set the following in the Box category:

a. Float: right

b. Margin: Top: 0, Right: 0, Bottom and Left: 15px

12. In the paragraph with the text "Return to Newsletter Main Page". Select Newsletter Main
Page as the text for a link back to the index.html main page of the newsletter. In the Property
Inspector panel, browse to the index.html page for the link.

13. Find the short quote from William Hertrich (q "What about a cactus garden?" William Hertrich
suggested.) The q element intended for short quotations (inline content) that don't require
paragraph breaks. The blockquote element is for lengthy quotations, such as entire
sentences, paragraphs, lists, or the like. The cite element is used to indicate where the
nearby content comes from—when quoting a person, a book or other publication, or generally
referring people to another source, that source should be wrapped in a cite element.

• Select the text and right click, and choose “wrap tag” from the contextual menu. Type q
and the quote element will be supplied. Press enter twice

• Select the words William Hertrich and again right click and choose wrap tag from the
menu. Type the letters ci and the cite element should be supplied, and press enter twice.

14. A blockquote element cannot contain text, but must instead have another block level element
inside it. If you are quoting a paragraph of text, use a paragraph; when quoting a list of items,
use the elements for lists; and so on. If the quote comes from another web page, you can
indicate this using the cite attribute and the URL.

• Select the entire paragraph quote marked with (blockquote) and right click, choose wrap
tag and type the letters bl and blockquote element will be supplied, press enter twice

• Select the text William Hertrich and right click, choose wrap tag and type ci and the
element cite will be supplied. Press enter twice.

15. Hope you had success and that this tutorial will help you develop an interesting and well
"seasoned" Newsletter for the month of your birthday!

16. In Advanced Part II we will demonstrate how to add the sidebar content and reorganize the
layout to accommodate it. Stay tuned.


